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1
Learn about Corticon installations

Progress® Corticon® is the Business Rules Management System with the patented rules engine that enables
you to automate sophisticated decision processes—without having to write code. This guide presents procedures
for accessing, downloading, and running Corticon installers, as well as providing dynamic access to information
about . Links to the Progress KnowledgeBase provide additional information about third-party software setup.

Note: The Corticon Installer wizards will install or update Corticon 7.x Java Server runtime components. You
can install Corticon products on a machine that has a previous version installed. Where a previous version is
installed, you must manage any port overloads that might result from running both versions.

Progress Corticon products
Progress Corticon distinguishes its development toolsets from its server runtime environments.

• Corticon Studio is the Windows-based development environment for creating and testing business rules.

• Corticon runtime components implement and manage web services and in-process servers for deploying
business rules defined in Corticon Studio:

• Corticon Server for Java is supported on various UNIX and Linux web service platforms, in-process,
and on various application servers. After you install it on a supported Windows platform, its runtime
artifacts can be redeployed

• Corticon Server for .NET facilitates deployment of Corticon Decision Services on Windows .NET
Framework and Microsoft Internet Information Services (IIS).

• Corticon Utilities enable a command line interface for the corticon Web Console, a utility for Corticon
command line operations, and a utility for command line compilation of multiple decision services.
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Note: Corticon Web Console enables administration of multiple remote Corticon Servers. The Web Console
is a separate installation that enables it to maintain autonomy to manage all the supported long-term Corticon
Server installations. Because it uses a different Java and a different Tomcat version, you cannot collocate the
Web Console with a Corticon Server. See the Corticon Web Console installation guide for details.

For details, see the following topics:

• Java requirements

• Download installer packages

• How to prepare for a Corticon installation

Java requirements
Corticon requires a supported Java distribution to run.

Corticon Studio
The Corticon workbench bundles a Java distribution for use in running Studio. This Java distribution should
not be used to run Corticon Server, Web Console or otherwise be used in a production or server environment.

Note: Cannot install Studio into an existing Eclipse— Corticon Studio ships with Java 11 or higher, which
introduces changes in how JAR files are handled: Java no longer supports the direct addition of custom JARs
to the classpath as earlier versions did. As a result, the ability to drop extension JARs into the Eclipse plugin
folder is no longer functional. The recommended method for adding extension JARs is in an installed Corticon
Studio either:

• For Eclipse tools, choose Help > Install New Software, and then typically choosing tools at
https://marketplace.eclipse.org/ .

• For your extensions, such as extended operators and service callouts, in a Rule Project, choose Properties
> Corticon Extensions.

Corticon Server and Utilities
The runtime components require the user to provide a supported Java distribution, as listed in "Corticon 7.2
Supported Platforms". The user is responsible for ensuring that this Java distribution has any required security
updates.

Note: You can verify the Java on the path by opening a command prompt window, and then entering java
-version. If you get Java 21 as the response, you are all set. Otherwise, you need to revise system variables
and perhaps even the environment variables.

Java distributions are available from multiple sources. One good source is Adoptium: https://adoptium.net/

Note: Corticon installers utilize an embedded Java distribution for the purpose of performing install and uninstall
operations. This Java distribution should not be used for any other purpose.
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Download installer packages
Corticon installers can be used to perform a new install or update an existing installation.

• When performing a new installation the installer will prompt for information about the installation.

• When updating an installation, such as when applying a service pack, the installer will perform the update
without asking for this information.

You can have multiple major.minor versions of Corticon components installed in distinct folders and they can
be run concurrently, although they must keep their workspaces separate.

If the same or later version of a Corticon 7.2 component is already installed at any location on the target
machine, an alert is posted that denies permission to continue.

To download Corticon installer packages:

1. Get credentials to access to download packages on the Progress Software Electronic Software Download
(ESD) site.

2. Log in, and then navigate to the Progress Corticon Server+.NET and Studio 7.2 page.

3. Click View License, and then click Download.

• Unpack the .zip file.

• Read and save the .txt file.

• Copy the .jar file, rename the copy CcLicense.jar, and then save it at a location that the Corticon
7.2 applications can either reference it or pick it up.

4. Locate, download, and save the required Corticon installer packages to a temporary location accessible by
the target machine.

Corticon installer packages

DownloadFormatPlatformProduct

PROGRESS_CORTICON_7.2_STUDIO_WIN_64.exeexeWindowsStudio

PROGRESS_CORTICON_7.2_SERVER_JAVA_WIN_64.exeexeWindowsJava server

PROGRESS_CORTICON_7.2_SERVER_JAVA_LNX_64.binbinLinux

PROGRESS_CORTICON_7.2_SERVER.NET_WIN_64.exeexeWindows.NET server

PROGRESS_CORTICON_7.2_UTILITIES_WIN_64.exeexeWindowsServer Utilities

PROGRESS_CORTICON_7.2_UTILITIES_LNX_64.binbinLinux

You can run all the product installers for a platform on one machine as they will collocate in the
Progress\Corticon 7.2 folder.

Note: There is no explicit download package for Docker. The Server download installs
C:\Progress\Corticon 7.2\Server\Deploy\Docker. See "How to deploy Corticon on Docker" in the
Deployment Guide.
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How to prepare for a Corticon installation
Before running installers
To avoid possible constraints on the installers, do the following:

• Review the supported platforms - Refer to the Progress Software web page Corticon Supported Platforms
Matrix to review the operating system versions for Corticon Studio, Corticon runtime components, and
supporting software.

• Stage your Corticon licenses - You will be asked for your license when you run the installer. You can skip
that step, and then add the license later, but the installations will not run until you have a license. For .NET
server you need a license that enables it on the IIS server.

• Confirm that you have Administrator permissions on the target machine - Administrator rights allow
the installer to copy all the Corticon files to their proper locations. You must have Administrator rights and
permissions to install this software. See your system administrator to obtain these rights.

• Verify file system access - Several Corticon features write files to the “home” directory structure. If the
target machine for the Corticon installation does not have read and write access to this directory, you need
to choose a directory location where Corticon will have both read and write access.

If you are evaluating Corticon
You can install Studio, start it, and get underway! The evaluation license enables you to access the sample
projects as well as develop your business rules projects, and then test the projects in an embedded test server.
To evaluate Corticon Server deployment, contact your Progress sales rep for a Corticon Server evaluation
license.

If you are upgrading Corticon
With each new release of Corticon, Progress strives to maintain full compatibility with prior releases. Sometimes
changes in technology or product requirements introduce incompatibilities that users need to be aware of when
planning an upgrade.

For detailed upgrade instructions, see the Corticon Upgrade Guide.

Progress Corticon : Installation: Version 7.210

Chapter 1: Learn about Corticon installations

https://docs.progress.com/bundle/corticon-supported-platforms/page/Corticon-7.2-Supported-Platforms-Matrix.html
https://docs.progress.com/bundle/corticon-supported-platforms/page/Corticon-7.2-Supported-Platforms-Matrix.html


2
Installing Corticon Studio

Corticon Studio is a standalone Windows application installed by the Corticon Studio installer.

What Corticon Studio installers provide
The installer wizard package includes:

• Corticon Studio rule modeling environment

• Corticon Server runtime for use in testing rules you create in Corticon Studio

• Java Runtime Environment (JRE)

• Sample projects

• API documentation for extending Corticon

Note: Corticon Studio is built on the Eclipse development platform. This enables you to customize Corticon
Studio with the addition of third party plugins, adding additional capabilities to Corticon Studio. However, you
cannot install Studio into an existing Eclipse. Corticon Studio ships with Java 17 which introduces changes in
how JAR files are handled: Java no longer supports the direct addition of custom JARs to the classpath as
earlier versions did. As a result, the ability to drop extension JARs into the Eclipse plugin folder is no longer
functional. The recommended method for adding extension JARs is in an installed Corticon Studio either:

• For Eclipse tools, choose Help > Install New Software, and then typically choosing tools at
https://marketplace.eclipse.org/ .

• For your extensions, such as extended operators and service callouts, in a Rule Project, choose Properties
> Corticon Extensions.
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System requirements for Corticon Studio
Refer to the Progress Software web page

The target system for a Corticon Studio installation requires:

• Supported Windows operating system

• 8 GB memory (16 GB or more recommended)

• 1.25 GB disk space

Corticon Studio licensing
Corticon Studio starts out with an embedded 90-day evaluation license that enables all features working
including deployment packaging of Decision Services, but not deployment.

After you obtain an appropriate license for Studio, it is easily applied by starting Studio, and then choosing
Window > Preferences, then Progress Corticon. Click the License File Browse button to navigate to your
valid license. The Corticon Studio license default location is the Studio's work directory, typically:
C:\Progress\Corticon_Studio_Work_x.x\license\Studio\.

Once you Apply and Close the Preferences dialog, the license is in effect immediately.

For details, see the following topics:

• Run the Corticon Studio installer wizard

• Options after installing Corticon Studio

Run the Corticon Studio installer wizard
To perform an installation of Corticon Studio 7.x to the latest release (x) :

1. Double click on the installer file, PROGRESS_CORTICON_7.x_STUDIO_WIN_64.exe, to launch the Corticon
Studio installer.

Note: While not typically required, if you are told to do an administrator install, right-click on the EXE file,
and then choose Run as administrator.

The installer opens in the installer wizard.

2. The first installer panel opens with information about the installer.
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3. Click Next to continue.

The Choose Install Folder panel opens.

4. Specify the installation location. The default location for the installation directory and the work directory are
as shown above. Either accept the default locations, or specify your preferred locations.
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5. Click Next.

6. The Corticon License panel opens:

• If you select Add Corticon license file to installation? on this panel, the entry area for the License
File lets you enter or choose the path where you have staged your license file on the local machine. In
the illustration, the license file are in the licenses folder.

• If you skip the selection, a normal installation will proceed. The Studio will open for your use with a 90
day limited use license. You need to get a Corticon Studio 7.x license, and then place it a staging location.
You then open Studio, choose Preferences > Progress Corticon, and then enter or browse to the
license's staging location.

Click Next to continue.

7. The Pre-installation Summary panel opens. Confirm that your installation location has adequate disk
space for the Corticon Studio components as well as at least 100 MB of workspace.

8. Click Install to continue.

An installation status window opens to display the state of the installation process. When the process has
finished, the Install Complete panel opens.

9. Click Done to quit and close the installer.

The installation or update of Corticon Studio 7.x is complete.

10. Start the Corticon Studio by launching Corticon 7.2 Studio in a command prompt:
"C:\Progress\Corticon 7.2\Studio\eclipse\Eclipse.exe"

Options after installing Corticon Studio
There a few settings you might want to adjust after installing Studio.
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Increase Corticon Studio memory allocation
When working on large Rule Projects, you will get better performance by increasing the amount of memory
available to Corticon Studio.

To change Corticon Studio memory allocation after installation, do the following:

1. Edit the command file eclipse.ini located at [CORTICON_HOME]\Studio\eclipse

2. Change (typically, increase) the Xmx value (maximummemory setting). The default Xmx setting is 2 gigabyte,
specified as Xmx2g. Often, that is increased to 4g when appropriate memory is available.

Set Studio to run in another language
You can specify a preferred language for Corticon Studio. The options are:

• English (en - default)

• French (fr)

• Japanese (ja)

• Portuguese (Brazilian) (pt_BR)

• Spanish (es)

To set Corticon Studio to start in your preferred language:

1. On Windows, right-click on the Start menu item for Corticon Studio, and then choose More > Open file
location.

2. Right-click on the shortcut Corticon Studio, and then choose Properties.

3. Choose the Shortcut tab, and then add to the Target value with the language option, -nl followed by a
language value, as shown setting ja for Japanese:
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4. Click Apply, and then OK to set the change.

When you start Corticon Studio its labels are in Japanese, as illustrated:

Note: A preferred user language might use different formats for decimals, dates and list ranges than shown
in the Corticon documentation.
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3
Installing Corticon runtime components

The Corticon runtime components allow you to deploy andmanage your Corticon decision services in production
and test environments. What you need depends on your deployment choices. The runtime component options
include:

• Corticon Server for Java: For deploying decision services to Java applications or application servers.

• Corticon Server for .NET: For deploying decision services to .NET applications or an IIS application server.

• Corticon Server Utilities: For orchestrating the packaging and deployment of decision services.

Using installer wizards—Each runtime component is provided as its own Windows installer.
Performing command-line Linux installations of Corticon components on page 26 enables the Linux installer
to run from the shell as a command with parameters.

For details, see the following topics:

• System requirements for Corticon runtime components

• Corticon runtime component licensing

• Installing Corticon Server for Java

• Installing Corticon Server for .NET

• Installing Corticon Server Utilities

• Installing Corticon Runtime on Tomcat

• Performing command-line Linux installations of Corticon components

• Performing silent installations
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System requirements for Corticon runtime
components

Progress Corticon products are supported on a variety of platforms and third-party components.

Corticon Server for Java
Refer to the Progress Software web page Corticon Supported PlatformsMatrix to review the currently supported
platforms and application servers. Also see the Corticon KnowledgeBase entry Corticon Server sample WAR
installation for different Application Servers for detailed instructions on configuring Corticon Server on all
supported platforms.

The target system for a Corticon Server for Java installation requires:

• Java 21 JDK

• Supported Windows or Linux operating system

• Application server (Documentation refers to Tomcat 10 with default port 8080 or 8850)

• 8 GB Memory (16 GB or more recommended)

• 600 MB disk space

Corticon Server for .NET
Refer to the Progress Software web page Corticon Supported Platforms Matrix for information on supported
.NET Framework and IIS versions as listed in the topic Prerequisites for setting up a Corticon .NET Server on
page 21.

The target system for a Corticon Server for .NET installation requires:

• Java 21 JDK

• Supported Windows operating system

• Supported .NET Framework and Internet Information Service (IIS)

• 8 GB Memory (16 GB or more recommended)

• 700 MB disk space

Utilities for Java Server
Corticon Server Utilities can be used when located on a remote machine to act on a Java Server or Web
Console installation.

• Java 21 JDK

• Supported Windows or Linux operating system

• 8 GB Memory (16 GB or more recommended)

• 700 MB disk space
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Corticon runtime component licensing
Corticon Server for Java
The Corticon Server license default location is in the Server's work directory:
C:\Progress\Corticon_Server_Work_x.x\license\Server\.

Note: Until you have a valid Corticon Server license for the current version, the Server will not run.

Corticon Web Console
The Corticon Web Console does not require any license.

Corticon Utilities
Corticon Utilities require either a valid Studio or Server license. The Corticon Utilities license default location
is in the directory: C:\Progress\Corticon_Utilities_Work_7.2\license\utilities\.

Copy your license file to that location.

Note: If your license location is different, then set the option that will locate it in each of the .bat files. Edit
each file, locate the option, and then change its path and value to your preferred path and name.

Corticon Server for .NET
Your license must enable Corticon .NET Server for the current version. Copy your .NET-enabled
CcLicense.jar file to C:/inetpub/wwwroot/Corticon/lib/.

Note: Until you have a valid Corticon .NET Server license for the current version, the Corticon .NET Server
will not run.

Web Console Managed Servers
The Web Console copies the CcLicense.jar (or its preferred name) from each managed server installation
to its CcServerSandbox, located on the machine hosting the Web Console Server.

Installing Corticon Server for Java
To create or update an installation of Corticon Java Server 7.x:

1. On the target machine, access the Corticon 7.x installers you downloaded.

2. To open the Corticon Java Server Setup Wizard:

• For Windows, double click on: PROGRESS_CORTICON_7.x.x_SERVER_WIN_64.exe

Note: While not typically required, if you are told to do an administrator install, right-click on the EXE
file, and then choose Run as administrator.
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• For Linux, run: PROGRESS_CORTICON_7.x.x_SERVER_LNX_64.bin

The installer opens in the installer wizard. The first installer panel opens with information about the installer.

Note: If the same or higher Corticon Java Server 7.x is installed at any location on the target machine, an
alert is posted that denies permission to continue. You will be able to apply Server 7.x service packs and
patches. You can have other major.minor versions of Corticon Server installed in distinct folders and they
can run concurrently, although they must run on separate ports.

3. Click Next to continue.

4. The Choose Server Java Install Directory panel opens.The default install directory is shown. To specify
a preferred directory, enter the explicit path, or click Choose to browse to the preferred directory.

5. Review the information in the Pre-Installation Summary panel.

6. Click Install to continue. The installation status window opens. When done, the Install Complete panel
opens.

7. Click Done to complete the Corticon Server for Java installation and close the installer.

8. CorticonWork folder—Create the folder C:\Progress\Corticon 7.2\Corticon_Server_Work_7.2.

a. Copy the brms.properties file from C:\Progress\Corticon 7.2\Server to theCorticonWork
folder.

b. ForCDDdeployment, copy the CDD file C:\Progress\Corticon 7.2\Server\cdd to theCorticon
Work folder.

c. Copy the license file to:

Corticon_Server_Work_7.2/license/Server/CcLicense.jar.

9. App Server—If deploying Corticon Server to an application server, follow the application server's guide for
installing the appropriate Corticon Server .war file from the server installation's C:\Progress\Corticon
7.2\Server\Deploy folder.

Installing Corticon Server for .NET
When you install .NET Server 7.2 on a machine that has an IIS Server setup that satisfies the prerequisites,
the Corticon .NET Server installer will install or update .NET Server 7.x.

To create or update an installation of .NET server 7.x:

1. On the target machine, access the Corticon 7.x installers you downloaded.

2. To open the .NET Server Setup Wizard on Windows, double click on:
PROGRESS_CORTICON_7.x.x_SERVER.NET_WIN_64.exe

Note: While not typically required, if you are told to do an administrator install, right-click on the EXE file,
and then choose Run as administrator.

The installer opens in the installer wizard. The first installer panel opens with information about the installer.

3. Click Next to continue.

4. The Choose Server .Net Install and Work Directory panel opens.
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5. The default installation directories are shown. To specify preferred directories on each line, either enter the
explicit path, or click Choose to browse to each preferred directory.

6. Click Next to continue. The Add Corticon License? panel opens.

• If you select Add Corticon license file to installation? on this panel, the entry area for the License
File lets you enter or choose the path where you have staged your .NET ENABLED license file on the
local machine. The license will be copied to the .NET server.

• If you skip the selection, a normal installation will proceed. However, Corticon .NET will not open for
your use here or on the IIS Server until you add an appropriate license file from a staging location. Copy
your .NET CcLicense.jar file to C:/inetpub/wwwroot/Corticon/lib/.

7. The default install directory is shown. To specify a preferred directory, enter the explicit path, or click Choose
to browse to each preferred directory.

8. Verify your selections in the Pre-Installation Summary panel. Nothing has happened yet so you can click
Previous to go back to a panel to make changes, or click Cancel to quit this installation procedure.

9. Click Install to continue. The installation status window opens. When done, the Install Complete panel
opens.

10. Click Done to complete the Corticon .NET Server 7.2 installation and close the installer.

11. In your .NET Server installation's C:\Progress\Corticon 7.2\Server .NET\IIS folder, run
install.bat as administrator, entering Y or A to install all the files.

The installation and update of Corticon .NET Server and its setup on IIS Server are complete. See the instructions
for "Web services on .NET" in the Web Services guide for additional information.

Note: Using an LDAP store for .NET Server authentication—You can set up Corticon .NET Server to
authenticate users using an LDAP server. See the topic "How to use LDAP for .NET Server authentication" in
the Web Console Guide.

More about .NET server on IIS
See:

• Prerequisites for setting up a Corticon .NET Server on page 21

• How to set up IIS server on page 22

Prerequisites for setting up a Corticon .NET Server
The runtime server for Corticon Server for .NET is Microsoft Internet Information Services (IIS), a distinct setup
into which you install and update with the latest Corticon Server for .NET resources.

Before installing the Corticon .NET Server resources:

1. Obtain an appropriate Corticon license for Corticon Server for .NET.

Note: You must obtain .NET evaluation and deployment licenses from your Progress representative.

2. Confirm that your target machine meets the system requirements. See System requirements for Corticon
runtime components on page 18 for more information. Corticon Server for .NET requires Java 17 as discussed
in Java requirements on page 8. Copy the JRE folder to C:/inetpub/wwwroot/Corticon/JRE.
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3. See the Progress Software web page Corticon Supported Platforms Matrix for information on supported
.NET prerequisites and Microsoft IIS.

4. Confirm that the IIS server has the features that Corticon .NET requires. You can set up or check the features
for IIS server in the topic How to set up IIS server

When you have the set up complete, see the instructions for "Web services on .NET" in the Web Services
guide to install the resources.

How to set up IIS server
You need to have the Microsoft Internet Information Services (IIS) set up on the machine where you intend to
install Corticon .NET server.

Note: Confirm that you have Visual Code C++ Redistributable 2012 x64(VC++ 11.0), Visual Code C++
Redistributable2015-22 (x64), and .NET Framework runtime 4.0 or higher. For details, see .NET Prerequisites
in the Supported Platforms matrix.

SupportedWindows andWindows Server installations include Internet Information Server (IIS) 10.0 but require
user interaction to enable it. Server Manager is installed by default with all editions of Windows Server. You
can use Server Manager in Windows Server to setup IIS as a role-based feature. While you can download a
Server Manager for Windows, this document describes the common functionality that turn Windows features
on.

To set up IIS 10 on supported Windows or Windows Server versions, perform the following steps:

1. In the Windows Search entry area, type appwiz.cpl, and then press Enter.

2. On the Programs and Features control panel, click Turn Windows features on or off.

3. In the Windows Features panel, select the following features:

Note: Some versions of Windows might not have World Wide Web Services in this dialog. Also the version
number of some features might be newer.
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4. Click OK. The required IIS features for Corticon .NET are turned on.

5. Reboot the computer.

6. In most browsers, when you type localhostin the URL entry area, the Microsoft IIS .NET home page
opens indicating successful installation. ClickWelcome to explore the features, forums, and community.

7. Continue the setup of Corticon Server on IIS at "Set up Corticon Server for .NET on IIS" in theWeb Services
Guide.

Installing Corticon Server Utilities
The Utilities installer will perform actions on 7.x Servers and Web Console.

To create or update an installation of Corticon Server Utilities 7.x:
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1. On the target machine, access the Corticon 7.x installers you downloaded.

2. To open the Setup Wizard:

• For Windows, double click on: PROGRESS_CORTICON_7.x.x_UTILITIES_WIN_64.exe

Note: While not typically required, if you are told to do an administrator install, right-click on the EXE
file, and then choose Run as administrator.

• For Linux, run: PROGRESS_CORTICON_7.x.x_UTILITIES_LNX_64.bin

The installer opens in the installer wizard. The first installer panel opens with information about the installer.

Note: If the same or higher Corticon Utilities 7.x is installed at any location on the target machine, an alert
is posted that denies permission to continue. You will be able to apply Utilities 7.x service packs and patches.
You can have other major.minor versions of Corticon Server installed in distinct folders and they can run
concurrently, although they must run on separate ports.

3. Click Next to continue.

4. The Choose Utilities Install and Work Directory panel opens. The default installation directories are
typically accepted. To specify preferred directories on each line, either enter the explicit path, or clickChoose
to browse to each preferred directory.

5. The Corticon License panel opens.

• If you select Add Corticon license file to installation? on this panel, the entry area for the License
File lets you enter or choose the path where you have staged your license file on the local machine. The
license will be copied to C:\Progress\Corticon_Server_Work_7.2\license\Server\.

• If you skip the selection, a normal installation will proceed. However, the Corticon Server will not open
for your use until you have a valid license. Corticon Utilities work with either a valid Studio or a Server
license.

6. Click Next.

7. Verify your selections in the Pre-Installation Summary panel. Nothing has happened yet so you can click
Previous to go back to a panel to make changes, or click Cancel to quit this installation procedure.

8. Click Install to continue. The installation status window opens. When done, the Install Complete panel
opens.

9. Click Done to complete the Corticon Utilities installation and close the installer.

The installation and update of Corticon Utilities is complete.

If you chose non-standard install paths, modify the paths in each of the utility .bat files in the bin directory.

Configuration Settings
JAVA_HOME

Ensure that the JAVA_HOME environment variable is set correctly and points to the appropriate Java version.
If you prefer not to set JAVA_HOME as a system-wide environment variable, you can configure Corticon Utilities
to use the correct Java version by setting the JAVA_HOME variable directly in the corticon_env.bat file,
located in the path:

C:\Progress\Corticon 7.2\Utilities\bin
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Add the following line to the corticon_env.bat file to point to the correct Java version:

rem
rem Conditionally set CORTICON_WORK to allow it to be overriden.
rem
if not defined CORTICON_WORK
set CORTICON_WORK=C:\Progress\Corticon_Utilities_Work_7.2
set "JAVA_HOME=C:/jdks/Java21/jdk-21.x.x" -> Location of Java

License
If a license was selected during installation, it was placed in the following location:

C:\Progress\Corticon_Utilities_Work_7.2\license\utilities\

To switch to a different license, copy your CcLicense.jar file to the same directory:

C:\Progress\Corticon_Utilities_Work_7.2\license\utilities\

Installing Corticon Runtime on Tomcat
Prior releases of Corticon included a bundled distribution of Tomcat. The following instructions provide guidelines
for installing Corticon Server and WebConsole into Tomcat to create a runtime environment similar to previous
Corticon releases. These examples are specific to Windows installations. The following topics on Linux
installations follow a similar pattern. For additional details, refer to the Corticon Deployment Guide.

Folder Setup
The steps below assume the following file system folder setup:

• C:\Java_21 : Java 21 installation

• C:\Tomcat_10 : Apache Tomcat 10 installation

• C:\Progress\Corticon 7.2: Default Corticon 7.2 installation

• C:\Corticon_Work_7.2: User chosen work directory for Corticon Server

Change the folder locations as needed in each step to match your configuration.

Install Tomcat
1. Download the binary distribution of Apache Tomcat for your platform from:

https://tomcat.apache.org/download-10.cgi For Windows, download "64-bit Windows zip".

2. Extract the downloaded files to:

C:\Tomcat_10

3. Deploy Corticon Server to Tomcat Edit the file: C:\Tomcat_10\bin\startup.bat, and then add the
lines:

set JAVA_HOME="C:\Java_21"
set CATALINA_OPTS=-DCORTICON_HOME="%CATALINA_HOME%"

-DCORTICON_WORK_DIR="C:\\Corticon_Work_7.2\\"
set JAVA_OPTS=%JAVA_OPTS% -Dfile.encoding=UTF-8
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4. Copy the file:

C:\Progress\Corticon 7.2\Server\Deploy\Tomcat\10\axis.war

to:

C:\Tomcat_10\webapps\axis.war

5. Configure Tomcat Ports (Optional) Edit the file:

C:\Tomcat_10\conf\server.xml

and then set the preferred ports (the port settings here reflect those previously used by Corticon):

<Connector port="8850" protocol="HTTP/1.1"
connectionTimeout="20000"
redirectPort="8851"
maxParameterCount="1000"/>

<Server port="8852" shutdown="SHUTDOWN">

6. Restart Tomcat. If Tomcat is running, stop it.

7. Start Tomcat by running:

C:\Tomcat_10\bin\startup.bat.

Performing command-line Linux installations of
Corticon components

A command-line install runs a Linux installation in a command shell as a text command with parameters.

To perform command-line installations for Corticon components on Linux:

1. On a supported 64-bit Linux platform, copy the downloaded Linux installer binary files to a temp directory
CorticonInstall:

• PROGRESS_CORTICON_7.2_SERVER_JAVA_LNX_64.bin

• PROGRESS_CORTICON_7.2_UTILITIES_LNX_64.bin

Note: The Corticon Web Console is set at version 7.1.1. As such, it requires Java 17 and Tomcat 9 (only),
and cannot be collocated with Corticon Server 7.2.

2. Copy the CcLicense.jar you created from the license download to /tmp/CorticonInstall.

3. Grant your installation user access to the installation directory:

> cd tmp
> sudo chmod 755 CorticonInstall

4. Review the files copied to the temp directory on your Linux machine:

> cd CorticonInstall
> ls
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5. Ensure that you can install each Corticon Server bin files by assigning the proper rights:

> sudo chmod 777 PROGRESS_CORTICON_7.2_SERVER_JAVA_LNX_64.bin

6. In a shell, run the binaries with the console option. For example:

# ./PROGRESS_CORTICON_7.2_SERVER_JAVA_LNX_64.bin -i console

# ./PROGRESS_CORTICON_7.2_UTILITIES_LNX_64.bin -i console

7. Follow the prompts to complete the installation via the command-line.

Note: The work directory path must not contain spaces.

Installing Corticon Runtime on Tomcat on Linux
The following instructions provide guidelines for installing Corticon Server 7.2 into Tomcat to create a runtime
environment similar to previous Corticon releases. For additional details, refer to the Corticon Deployment
Guide.

Note: The Web Console 7.1.1 is a separate download and install as it requires Java 17 and Tomcat 9.

Folder Setup
The steps below assume that the Linux system folders are setup as follows:

• /usr/lib/jvm/java-21-openjdk/amd64 : Java 21 installation

• /opt/tomcat : Apache Tomcat 10 installation

• /usr/local/Progress/Corticon 7.2: Default Corticon 7.2 installation

• /opt/tomcat/work: User chosen work directory for Corticon Server

Change the folder locations as needed in each step to match your configuration.

How to install Corticon Runtime on Linux

Note: These steps describe how to install Corticon Server on Tomcat. The steps are conceptually the same
for other supported app servers (see Corticon Supported Platforms Matrix) even though the semantics will
likely vary.

Perform the following steps:

1. Create a dedicated Tomcat user and group:

> sudo useradd -r -s /sbin/nologin tomcat
> sudo groupadd tomcat
> sudo usermod -aG tomcat tomcat

2. Install Tomcat:
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Download the binary distribution of Apache Tomcat for Linux platform from:
https://dlcdn.apache.org/tomcat/tomcat-10

a.

b. Extract the downloaded files to:

> sudo mkdir /opt/tomcat
> sudo tar xzvf apache-tomcat-10*tar.gz -C /opt/tomcat --strip-components=1
> sudo chown -R tomcat:tomcat /opt/tomcat

c. Adjust the file and directory permissions:

> cd /opt/tomcat
> sudo chmod -R 755 /opt/tomcat/bin
> sudo chmod -R 644 /opt/tomcat/conf
> sudo chmod -R 644 /opt/tomcat/lib
> sudo chmod -R 664 /opt/tomcat/logs
> sudo chmod -R 777 /opt/tomcat/temp
> sudo chmod -R 755 /opt/tomcat/webapps
> sudo chmod -R 777 /opt/tomcat/work

3. Prepare Tomcat for the Corticon Server:

Note: The log file location, CDD location, and Decision Service deployment file location all depend on the
CorticonServerWork directory. To change the CorticonServerWork directory, add a trtup.sh to the Tomcat
bin directory. Edit the setenv.sh file to include the example CATALINA_OPTS line below. The setenv.sh
file will be initialized by the Tomcat catalina.sh file automatically to set the CorticonServerWork directory.

a. Edit the file: =/opt/tomcat/bin/startup.sh , and then add the lines:

Environment=JAVA_HOME=/usr/lib/jvm/java-21-openjdk-amd64
Environment=CATALINA_PID=/opt/tomcat/temp/tomcat.pid
Environment=CATALINA_HOME=/opt/tomcat
Environment=CATALINA_BASE=/opt/tomcat

ExecStart=/opt/tomcat/bin/startup.sh
ExecStop=/opt/tomcat/bin/shutdown.sh

b. Create the work directory:

> sudo mkdir /usr/local/Progress/Corticon_Server_Work_7.2

Create the setenv.sh file:

> cd /opt/tomcat/bin
> sudo nano setenv.sh

c. Add the export Tomcat and Java options to setenv.sh:

export CATALINA_OPTS="$CATALINA_OPTS
-Dfile.encoding=UTF-8
-DCORTICON_WORK_DIR=/usr/local/Progress/Corticon_Server_Work_7.2
-DCORTICON_SETTING=SER

-CORTICON_LICENSE=/usr/local/Progress/Corticon_Server_Work_7.2/license/Server/CcLicense.jar

-DCORTICON_SETTING=SER"
export JAVA_OPTS="-Xms1g -Xmx2g"
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d. Modify the execution permissions for this file to Tomcat user group:

> chown :tomcat ./setenv.sh
> chmod g+x ./setenv.sh

e. Install the license:

> cd /usr/local/Progress/Corticon_Server_Work_7.2
> sudo mkdir license
> cd license
> sudo mkdir Server
> sudo chmod 644 /usr/local/Progress/Corticon_Server_Work_7.2/license/Server
> sudo cp /tmp/CorticonInstall/CcLicense.jar
/usr/local/Progress/Corticon_Server_Work_7.2/license/Server

f. Install the .war files into Tomcat:

> sudo cp /usr/local/Progress/Corticon_7.2/Server/Deploy/Tomcat/10/axis.war
/opt/tomcat/webapps/

Start Tomcat: Reload systemd and start Tomcat:

> sudo systemctl daemon-reload
> sudo systemctl start tomcat
> sudo systemctl enable tomcat

To confirm that Corticon server is running, in Linux enter:

> curl http://<Server IP>:8850/axis/corticon/server/ping

Configure the app server installation
Several tunings can improve your installation. Restart the app server after you make any changes.

• Date and time-Check your Linux Server's date/time settings, especially in Cloud implementations. Your
local time should be properly recorded in the Web Console statistics and Corticon Server log files.

• Encryption-Use HTTPS and then see the topics under Secured deployment on Java web services

• Tomcat Port: Edit the file:

> cd /opt/tomcat/conf/
> sudo nano server.xml

and then set the preferred ports (the port settings here reflect those previously used by Corticon):

<Connector port="8850"
protocol="HTTP/1.1"
connectionTimeout="20000"
redirectPort="8851"
maxParameterCount="1000"/>

<Server port="8852" shutdown="SHUTDOWN">

• BRMSProperties:—The brms.properties file is installed by default with several commented-out options
to help you tune the behavior of a Corticon deployment. For additional properties, see "Server Properties
and Settings"" in the Server guide. If you are upgrading from a previous version of Corticon, you should
assess the differences between the prior file and the installed one, and then either reuse the prior file or
update the installed file. To copy it to the Corticon Server Work directory:

> sudo cp /usr/local/Progress/Corticon_7.2/Server/brms.properties
/usr/local/Progress/Corticon_7.2/Corticon_Server_Work_7.2/brms.properties
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Any changes to the brms.properties file are not implemented until you restart the Tomcat service.

• Tomcat as a service - Create a systemd service file to run Tomcat as a service. This ensures that if your
Linux machine is rebooted, Tomcat and Corticon will auto-start:

> sudo nano /etc/systemd/system/tomcat.service

Add content to the Tomcat service definition:

[Unit]
Description=Tomcat Corticon Server 7.2
After=network.target

[Service]
Type=forking
Environment=JAVA_HOME=/usr/lib/jvm/java-21-openjdk-amd64
Environment=CATALINA_PID=/opt/tomcat/temp/tomcat.pid
Environment=CATALINA_HOME=/opt/tomcat Environment=CATALINA_BASE=/opt/tomcat

ExecStart=/opt/tomcat/bin/startup.sh
ExecStop=/opt/tomcat/bin/shutdown.sh

User=tomcat
Group=tomcat
UMask=0007
RestartSec=10
Restart=always

[Install]
WantedBy=multi-user.target

Performing silent installations
An unattended (silent) install requires that you first run an installation or updater in the installer wizard to capture
the selected options, and then use the captured response file on other targets to 'playback' the responses into
the installer without any user interaction.

To perform silent installations of Corticon Studio:

1. Run the Studio installer with your preferred locations and options to capture a response file, using the syntax
installer.exe -r file where installer is the preferred Studio installer, and file is the response
file you will reuse. For example, PROGRESS_CORTICON_7.x_STUDIO_WIN_64.exe -r
C:\CorticonStudio64_7x.responses

2. On other target machines, access the Studio 7.x installer executable and the response file.

3. On those machines, run the installer using the syntax installer.exe -i silent -f file where
installer is the Studio installer, and file is your response file. For example,
PROGRESS_CORTICON_7.x_STUDIO_WIN_64.exe -i silent -f
C:\CorticonStudio64_7x.responses.

An unattended (silent) install requires that you first run an installation in the installer wizard (Windows or Linux)
to capture the selected components and options, and then use the captured response file on targets on the
same platform to 'playback' the responses into the installer without any user interaction.

Silent installations or updates for runtime components on Windows:
1. Run the runtime component installer with your preferred locations and options to capture a response file,

using the syntax installer.exe -r file where installer is the preferred installer, and file is the
response file you will reuse. For example:
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PROGRESS_CORTICON_7.x_SERVER_WIN_64.exe -r C:\CorticonServer_7x_WIN.responses

2. Then, on other target Windows machines, access the Server 7.x installer executable and the response file.

3. Run the installer using the syntax installer.exe -i silent -f file where installer is the
Server installer, and file is your response file. For example:

PROGRESS_CORTICON_7.x_SERVER_WIN_64.exe -i silent -f
C:\CorticonServer_7x_WIN.responses

Silent installations or updates for runtime components on Linux:
1. Run the runtime component's Linux installer with your preferred locations and options to capture a response

file, using the syntax installer.bin -r file where installer is the preferred Server installer, and
file is the response file you will reuse. For example:

PROGRESS_CORTICON_7.x_SERVER_LNX_64.bin -r
/usr/corticon/CorticonServer_7x_LNX.responses

2. Then, on other target Linux machines, access the Server 7.x installer binary and the response file.

3. Run the installer using the syntax installer.bin -i silent -f file where installer is the
Server installer, and file is your response file. For example:

PROGRESS_CORTICON_7.x_SERVER_LNX_64.bin -i silent -f
/usr/corticon/CorticonServer_7x_LNX.responses
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4
Uninstalling Studio and runtime components

You can remove distinct subsets of C:\Progress\Corticon 7.x\ by running the individual uninstallers.
To remove them all, proceed through each component's uninstaller.

Note: Uninstalling Corticon Studio or runtime components removes a complete major.minor version of those
products, including any service packs or hotfixes applied. It is not possible then to uninstall just a service pack
or hotfix.

Uninstalling Corticon Studio
To remove a version of Corticon Studio, do the following:

1. Close Corticon Studio.

2. Choose theStartmenuControl Panel functionPrograms and Features, and then double-click onProgress
Corticon Studio 7.x to launch its uninstaller.

The installed files in the Studio's [CORTICON_HOME] are removed. Files you created (including the complete
workspace) are NOT removed or replaced during this process.

If the Uninstaller program is unable to fully remove components (usually because they are open), it will display
messages, and might require a reboot to complete the process.

Uninstalling runtime components
The runtime components -- Corticon Server for Java, Corticon Server for .NET, Corticon Web Console, and
Corticon Utilities use the common installation directory, yet you can choose to uninstall just selected components.

To uninstall deployment components on Windows:
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1. Stop the components on the machine.

2. Backup any files you want to retain.

3. Choose the Start menu Control Panel function Programs and Features, and then double-click on the
Progress Corticon 7.x component you want uninstall to launch its uninstaller.

Note: You could initiate the same task directly by navigating to the component's uninstall folder, and then
run the uninstall executable.

To uninstall Corticon Server on Linux:

1. Stop the components on the machine.

2. Backup any files you want to retain.

3. In a command shell, navigate to [CORTICON_HOME]\Uninstall Progress Corticon <component>
7.x, and then run the component's uninstall bin.

Note: Files you created are NOT removed or replaced during this process. No server files in the
[CORTICON_WORK_DIR] are removed.
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